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5. Structure Manager

5.1. basics

5.1.1. introduction

The Structure Manager allows you to create general product structures (BOM = Bill of Material) that
can be configured to display the product structure at a specific time or for a specific unit, such as

e The valid component structure of an assembly

¢ A specific approved manufacturing design of the product
e The current design structure in product development

e The product structure that was valid on a certain date

¢ A specific variant of a product

By creating a single generic structure that can then be configured to meet individual user
requirements, assembly structures do not need to be duplicated. This avoids the associated problems
of maintenance, redundant information and search complexity. The list is similar to the bill of
materials that design departments use to list manufacturing information.

5.1.2. opening the structure manager

Start the Structure Manager (PSE) in the navigation window of the TC Client.

rrrrrrrrr

g} Erste Schritte

Mein Teamcenter

Struktur-Management
% Lifecycle-\iewer

E' Anderungsverwaltung

This opens the application with a new and empty window.

Struktur-Management 5

Keine Struktur - Latest Working - Datum - "Heute"

Sticklisteneintrag Regel kanfigurie... / | Elementdnderungsstatus | Pos.

To open an existing BOM view revision status (BVR = BOM View Revision) in the Structure Manager,
use one of the following options:

* Double click on the parts list view (View)
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a T X.0000.3311 STAENDERBAUGRUPPE

{7 X.0000.3311-Ansicht

4 g ¥.0000.3311-00 STAENDERBAUGRUPPE ER

[»

[ﬁ Ansicht
7 X.0000.3311-00 ER

of;; X.0000.3311/00-Ansicht ER

ER ER

* Right mouse button on selected item / item revision or view - Send to - structure

management

D :J’ PaTaTuls i bl I LT WY ol
:E of"  Ausschneiden Strg+X

®.00018 [ Kopieren Strg+(C

- Bericht erstell

00014 _ErIC erstellen

0004 .2 Offnen mit 4

104.0521 Senden an L Berichterstellung

l Einchecken/Auschecken r Beziehungs-Browser
Fertigungsprozessplanung
Altualisieren F5

& [,

Eigenschaften bearbeiten
Zugriff...
Projekt

Zu Favoriten hinzufiigen

U= L s X g

Lifecycle-Viewer
Mehrfachsticklistenverwaltung
Mein Teamcenter
Multi-5tructure-Management
Struktur-Managerment
Workflow Viewer

Zeitplan-Management

5.1.3 Overview of the Ul

#.0000.3311-00 STAENDERBAUGRUPPE (Ansicht) - Latest Working - Datum - "Heute"

Stacklisteneintrag 1 Reoel konfigurie,., 1 Elementﬁnderungsstatusl Pc

= X.0000.3311-00 STAEND..
9P X.0000.3011-00 SCH...
-9 X.0000.2875-00 GEG...

EI gﬁ #.0000.3390-00 TEM...

ER

Hat Status( Beliebig... ER
Hat Status( Beliebig... ER
Hat Status( Beliebig... ER
: ﬁ'XUUUUEEUU 00 K... Hat Status( Beliebig... ER
: QGKDUUUESE- Hat Status( Beliebig... ER
----- f #.0000,3115-... Hat Status( Beliebig... ER

10
20
30
10

10
©

IM Display of the assembly structure in the form of expandable tree diagrams in list form

Display of the columns can be configured as desired.

Usually corresponds to the design structure coming from the CAD - However, components without
l geometry (additive, auxiliary materials, ...

) can also be stored here
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IW Modified? YES/NO
subassembly
BN Component

#.0000.3311-00 STAEMDERBAUGRUPPE

Stocklisteneintrag
= X.0000.3311-00 STAENDERBAUG...
e3P %.0000.3011-00 SCHMIERUN...
[+ X.0000.2875-00 GEGEMLAGE...
-4 X.0000.3390-00 TEMPERATU...
- @ X.0000.3600-00 KABELSA...

[ 2 X.0000.2952-00 SENS...
g X.0000.3115-00 STEC...

5.1.4. Anpassen der Oberflache

Tabellenfunktionsmend
Spaltenauswahl aktivieren o

Ausgewdhlte Daten kopieren

== Diese Spalte entfernen
+ Spalte(n) einfigen...

lm] Spaltenkonfiguration speichern

= Eine Spaltenkonfiguration anwenden

Tabelle drucken

Spalte(n) einfrieren...

Printed on 2025/10/17 09:20

Die angezeig

Spalten als Spaltenk ion speichern. Diese gespeicherten

P g
Zeitpunkt angewendet werden.

kénnen mit "Spaltenk g d den” zu einem spél

| Name DRWE Definition M
Iy Mit Uberschriften [PSE Training|
Beschreibun
[y OhneHeader 9
Fir Abfrage
Speichern Abbrechen I
Eine vorher gespeicherte Spaltenkonfiguration fr die
aktuelle Ansicht anwenden oder lhre gespeicherten
HTML / Text Spaltenkonfigurationen llen, l6schen oder
Grafiken bearbeiten.

Spaltenansichten

(Benutzer)DRWE Definition

P E>

[ Anwenden | [ SchlicB‘en ]

HSWitch between column and row selection

Freeze desired columns while scrolling. Same column function as in MS Excel.

5.2 Introduction to the Structure Manager

5.2.1. change status rule

For each BOM entry in the structure, this configuration method determines the change status of the
associated element, which is configured according to the change status attributes - for example,
release status, validity, or owner. When you open a structure in the Structure Manager, a change
status rule is always active. This rule consists of various parameters, which Teamcenter uses for
evaluation. According to the criteria defined in the change status rule, an available change status is
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provided for each element in the structure. If no change statuses are found, the Structure Manager
displays three question marks ??? for the corresponding entry and the structure cannot be extended

beyond this point.

Struktur-Management &3

#.0000.3311-00 STAEMDERBAUGRUPPE (Ansicht] - Latest Working - Datumn - "Heute”

Sthcklisteneintrag Regel kenfiguriert v...| Elementinderungsstatus P
!56 #0000.3311-00 STAEMDERBAUG... ER
Eﬂ--ﬁﬁ 2.0000.3011-00 SCHMIERUM... Hat Status( Beliebig... ER 10
EEI"&.G X.0000.25875-00 GEGEMLAGE... Hat Status( Beliebig... ER 20
Komponente Anderungsstand Status Laderegel
Revision 1 Gesperrt Alter Stand
Komponente Revision 2 Produktiv Aktueller Stand
Revision 3 Zukinftig. Stand

Assembly structures can be changed in the Structure Manager to

e specific times
e with certain characteristics

can be considered at any time.

Future developments can also be taken into account by indicating new revisions that are still in

progress.
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Anderungsstandregelin Arbeit, Status = Released
In Arbeit (1), oder) Status = Released (2)

Printed on 2025/10/17 09:20

Anderungsstandregel Status = Released

BG_100/B BG_100/B
Released Released
Ko_001/A Ko_001/B Ko_001/A Ko 001/B
Released in Arbeit Released in Arbeit
|$0_005’(_ A Ko _005/7?? Keine Revision zur
in Arbeit ™ in Arbeit Erfullung der Regel
BG_20/A BG_20/B
Released Released BG_20/A BG_20/B
Released Released
Ko 011/A [ Ko _011/B
Released In Arbeit Ko 011/A Ko 011/B
Released In Arbeit
Ko 012/A
Rel d
S Ko_012/A
Released
GRAU=
Entspricht der konfigurierten
Anderungsstandregel.

When you open a structure in the Structure Manager, always a change status rule is active. To apply
a change status rule to the current product structure, use the icon in the toolbar or call the following
menu function -» Tools -» Change status rule.

5.2.2. precise / imprecise assembly structures

The Structure Manager allows you to create and manage the following assembly accuracies:
Imprecise assemblies —» are dynamic element structures

An imprecise assembly contains links (items) to parts of its component.

With imprecise assemblies you can see the product structure (BOM) that is configured with the
relevant element change statuses. The change status rule selected for the window is taken into
account.

Precise assemblies - are fixed structures of specific part change states

A precise assembly contains links (items) to elementary change states of its component. If you
change a component to a new change status, you must update the assembly manually so that the old
change status of the component is removed and the new change status is added.

(In the future, FFG will work with imprecise assembly structures)
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BG_100/B BG_100

Ko 001/B Ko 001/A Ko 001/B

Ko_005

I Precise = there are only Revisionen built in

New revisions have no effect on the defined assembly -» must always be updated manually
 Imprecise = Components are installed as Item

ZBNew revisions are automatically integrated.

Precise assemblies are helpful in the case of prescribed, so-called revision control, such as in the case
of safety-relevant or documentation-obligatory products. Changes to approved precision assemblies
always result in a revision of the entire assembly.

5.3 Working with the Structure Manager

5.3.1. creating a structure

You can create the product structure manually in Teamcenter, import it from the CAD system or clone
an existing structure to use it as a basis for a structure. Generally, assemblies are created in the
MCAD system and transferred to Teamcenter.

Create an assembly in Teamcenter Structure Manager:

Send an existing item revision in the context menu with » Send to -» Structure Management.
'INow the components can be added.

In both cases, a BOM view is automatically assigned to the revision, following the change status rule.

The designer creates his assembly in the integrated CAD system and saves it in Teamcenter.
This means that all modifications in the native CAD design are automatically saved and synchronized
in Teamcenter.

5.3.2. create a structure object

Create a new BOM view change status directly on a previously selected item revision in the menu File
- New -» BOM view change status or CTRL+B.
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i MNeuer Anderungsstand der Stiicklistenansicht 2
e
- Erstellen neuer Anderungsstand der SLA far:
DE Elernent-ID / Anderungsstand-ID - Mame
MEProcess  ||x 0000.3091 /00 - |ABSTECKBOLZEN
D'[E Erstellt als: () Prdzize @) Unprizise
MESetup
1e Liste der Ansichtstypen zeigt all wertiigbaren Ansichtstypen auf Grundlage der eingegebenen Element-
P Die Liste der Ansichtstyp igt all werfligh Ansichtstyp f Grundlage der eingegeb El
und Anderungsstand-I0s an, YWenn eine beliebige ID ungiltig ist oder alle Ansichtstypen venvendet werden,
ist die Liste der &nsichtstypen leer, Sie kdnnen eine andere ID eingeben
weodurch die werflgbaren &nsichtstypen ermittelt und angezeigt werden,
Beim Erstellen Gffnen
’ oK ] ’ Anwenden ] ’ Abbrechen ]
View Type An attribute of a BOM view change state that indicates its purpose (such as design,

manufacturing). The administrator can define any number of view types.

Change Status |Element ID and Change Status ID

precision option|Definition of a precise or imprecise structure

5.3.3 Creating components

Once the assembly structure is created, the component can be added using various approaches.

1./Create item with File » New - Item

Copy / Paste method:

a.) Copy the component (or subassembly) to “My Teamcenter” (CTRL+C)
2.|b.) Switch to the Structure Manager

c.) Select the line under which the component is to be inserted

d.) Paste with (CTRL+V)

Quickly add components from the status bar
'Menu - Edit -» Add
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¥ Hinzufigen P

Hinzufiigen zu:

Hinzuzuflgende Komponente:

Element-ID: | X.0000.0005 Anderungsstand: |00 v
Elerentname: MAIN SPINDLE

Name: X.0000.0005 MAIN SPINDLE f]
Ansichtstyp:

@ Als Kemponente der ausgewdhlten Baugruppe
Als Ersetzung des ausgewihlten Eintrags

Als neue Ebene oberhalb der ausgewahlten Eintrage

Anzahl Positionen |1 e

Anzahl pro Position

Positionsnummer |40

’ QK 9 Anwenden ] ’ Lézchen ] ’ Abbrechen ]

&2 Nach Namen &ffnen @
Mame
D [x

Objekt Typ Bezichung

P X.0000.2581 KAB...|FFG

Engineering Item

9 X.0000.2583 PLU... |FFG

Engineering Item

T X.0000.2884 PNE...|FFG

Engineering Item

) X.0000.2886 HA... |FFG

P X.0000.2857 BEF... |FFG

Engineering Item e

Engineering Item

< | n

| 3

26298 Objekt(e) gefunden (

26-30 angeze.. I—EI

iIM Open object by name

Search Item-1D

BB Open the corresponding item with a double click
B Select desired change status

s Define number of positions

M Assign position number

5.3.4 Changing and deleting components

.

5.3.5 Replacing components

1.|Menu item - Edit - Replace (without...)

The selected component is immediately replaced with the one from the clipboard.

2.Menu item - Edit -» Replace

name is derived from the part ID entered

A selection dialog appears in which the element ID of the replacing component can be entered. If
the replacing component is contained in the clipboard, the fields for the element ID and change
status are already filled in. You can change the ID if necessary, but not the part name; the part

10/26
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== Ersetzen

Original
X.0000.2945-00 STAUFFSCHELLE

Anderungsstand:

Ersatz
Element-ID:

1

Elementname:
MName:

Ansichtstyp:

Ersetzen

@ Das Original

o: ! Angrenzende Positicnen

() Alle Positionen in }.0000.2996-00 HALTERUNG (Ansicht)

0K e Abbrechen

Printed on 2025/10/17 09:20

% Nach Namen &ffnen ﬁ
Name
DX 4 Suchen

Objekt Typ Beziechung Eigent.. Grupp

P X.0000.0002 LO... |FFG Engineering ftem Dog, Jo.. |[ELFFG =~
9 X.0000.0003 PIN |FFG Engineering Item Doe, Jo... [ELFFG | _
9 X.0000.0004 HO... |FFG Engineering Item e Doe, Jo... |[ELFFG |—
9 X.0000.0005 MAL..|FFG Engineering Item Doe, Jo.. [ELFFG
-“l S ASOS DT TR l—[l[—rﬂ - - - ™ [aY [ N ol ol -
[26298 Objekt(e) gefunden (1-5 angezeigt ) { =

I8 Open object by name

Search ltem-ID

Bl Open the corresponding item with a double click

/8 Select desired change status

o) Define replacing object

8 Confirm process

5.3.6. item numbers and quantities

An adjustment of the position numbers (also Search Number / Find No.) causes an update of the

display sequence of the BOM structure.

Stdcklisteneintrag |Hegel kn:nnfiguriertv...| Elementdnderungsstatus | Pos | Menge | MaBeinheit
 X.0000.2596-00 HALTERUNG (An.. & |
(-9 X.0000.3091-00 ABSTECKBOL... Hat Status( Beliebig... ER 10 Jede
g X.0000.2927-00 Hat Status( Beliebig... ER 20 jede
g X.0000.2945-00 STAUFFSCHE... Hat Status( Beliebig... ER 20 jede

If no special unit of measurement is defined in the item, the system uses the unit of measure
Every/Each. In the system, the default entry Each is configured to Piece. The specified value must be

an integer.

A unit of measure at the item (not in the structure) cannot be changed afterwards, as long as this is

built into a structure!

The Quantity column is the total quantity represented by the item, which is greater than one if the
item is compressed or if the component serves as a collective item.

5.3.7. packed display of lines
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Sticklisteneintrag

Ay el G LAnsicht)

A W .

Ay (ulalafl

00001z,

A

- Select the lines that you want to pack or unpack.
R The item number (search number) must be identical for all
B components.

-

----- S g o011y

5 (au]u]

S g o001

5 (au]u]

= 00012

b O . .
o 4 Perform packing / Unpack selected lines
Sticklisteneintrag

S 00 )

jjj j Result

S g 00001

S g 00001

00001 2

5.3.8. forced components

CAD components which are positioned in the CAD system with an assembly constraint are marked
with a corresponding icon in the Structure Management and receive the attribute Position constrained
= TRUE in the structure component properties.

Sticklisteneintrag

|Regel konfiguriert v... Elementﬁnderungsstatusl Pos, | Menge| MaBeinheit | Position zwangsbedingt

=% X.0001.8631-00 MULTI SPINDLE HEAD (Ansicht)
2 X.0001.8637-00 ABSTECKBOLZEN (Ansicht)

- @P%) X.0001 8644-00 Z¥YLINDERSCHRALBE
%2 X.0001.8639-00

- %9 X.0001 8644-00 Z¥YLINDERSCHRALBE
- %) X.0001 8644-00 Z¥YLINDERSCHRALBE
- @P%) X.0001 8644-00 Z¥YLINDERSCHRAUBE
- %e) X.0001.8638-00

= X.0001.8637-00 ABSTECKBOLZEN (Ansicht)

@ %) X.0001 8644-00 Z¥YLINDERSCHRALBE
- @P%E) X.0001.8639-00

5.3.9. arrangements

In Arbeit( )
In Arbeit( )
In Arbeit{ )
In Arbeit{ )
In Arbeit( )
In Arbeit( )
In Arbeit{ )
In Arbeit( )
In Arbeit( )
In Arbeit( ]

10
10
20
30
40
50
60
20
10
20

Jjede
jede
jede
jede
Jjede
jede
jede
Jjede
jede
jede

Falsch

Falsch

T Wahr
T Wahr
@ Wahr
% Wahr
& Wahr
T Wahr
Falsch

& Wahr
& Wahr

In CAD, you can define arrangements to determine alternative items for components in the assembly
and save these alternatives with the assembly. For example, the assembly of a machine can have
several arrangements if individual components are to represent different usage positions of the

machine.

The position of certain components is overwritten accordingly. You can also suppress components in a
particular arrangement, for example, to hide ejectors. If you manage an assembly with arrangements
in Teamcenter, each component in CAD has a corresponding position in Teamcenter and each

overwriting or suppression has a corresponding absolute position.

12/26
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If the structure contains orders, permanent transformations are applied to all orders by default.
5.3.10. Structural component properties

You can add non-geometric components to assemblies in the MCAD system or in Structure
Management. These do not have geometry for display in the graphics window of the CAD system.
Examples of non-geometric components are

e Lacquer
Adhesive
Lubricants
Hydraulic fluids
Instruction leaflet

A component used only as reference is removed from the parts list of its parent component in the
MCAD system and from the view of its parent component in Teamcenter Structure Manager. Examples
for reference components are

e Auxiliary or dummy parts
e Supplied or purchased parts whose structure is used in CAD, but is purchased as a complete
part. Therefore, only one item should appear in the BOM.

In the CAD system NX the properties of the corresponding components can be defined. A multiple
selection is possible.

Right click on desired part - Properties

£} Component Properties O X

e

Assembly | Attributes  Weight PartFile  General Parameters H
General v
Component A

[[] Cornponent is Reference-Only
[7] Cormponent is Mon-Geometric

[~

Apply Cancel

@ Component serves exclusively as reference

¥ (g X.0001.8644-00 ZYLINDERSCHRAUBE | X.0001 8644 00 @ ZYLINDERSCHRAUBE

@-}J ..Component is not geometric

— {7} Ry X.0001.8642-00 | x.0001 8642 00

In Teamcenter Structure Manager the reference components are not displayed. Of course, this also
applies to the components suppressed in the MCAD system.

The non-geometric components get the attribute UG-Geometry=NO and are marked with a special
icon. Components with a UOM <> each (each)/piece are automatically loaded into the CAD as
reference components.
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If a sub-assembly is marked as non-geometric, all underlying components are not loaded into NX
either.

Stdcklisteneintrag GEOMETRIE
=y X.0001.8631-00 MULTI SPINDLE HEAD | MEHRSPINDELKO...
- X.0001.8637-00 ABSTECKBOLZEN (Ansicht)

G- X.0001.8637-00 ABSTECKBOLZEN (Ansicht)

=g B9 X.0001.8642-00 (Ansicht) NO
----- o X.0001.8641-00 VERTEILER

----- & X.0001.8646-00

----- o X.0001.8646-00

----- & X.0001.8640-00 V-SCHLITTEN
----- & X.0001.8630-00 VERTEILER

----- & X.0001.8646-00

----- o X.0001.8646-00

- X.0001.8633-00 (Ansicht)

Altreps (alternative representations) can be used to define different physical configurations or shapes
of a flexible part (for example, a tube or hose).

In Teamcenter Structure Manager, alternative representations of components are defined and
displayed using the column UG ALTREP.

B Struktur-Management

1000007/A;1-Base Assembly (Ansicht) - Latest Working - Datum - "Heute"

Stidcklisteneintrag Elermenttyp Regel konfiguriert von s UG-GEOMETRIE UG ALTREP
—_‘.- 1000007/4;1-Base Assembly (Ansicht) Element

e —‘:b 1000004/ 4;1-Lower Base Element In Arbeit{ ) 1000004-A_A01
- -‘1@ 1000005/B:1-Mid Base Element In Arbeit{ ]
%% 1000006/B:1-Upper Base Elernent In Arbeit{ )
A 1000008/ A;1- Assembly instruction Element Hat Status( Beliebiger Fr...
5% 100001082 -E- i In Arbeit(

5.3.11. Capturing configurations

Teamcenter has, among others, the following formats for permanently recording the configuration of
a structure.

5.3.11.1. Snapshot

A snapshot is a workspace folder that stores a reference to all element change states contained in a
configured structure.

You can use a snapshot to save the product structure with a particular configuration and implemented
change state rules and display it again at a later time by sending the snapshot folder to the Structure
Manager. However, all change statuses that have not been released can be changed, such as linked
data and CAD models.

For this reason, it makes sense to create snapshots only of completely released product
structures!

14/26 Printed on 2025/10/17 09:20
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5.3.11.2. Snapshot manuell erstellen

1. Configure the structure to be saved by applying the corresponding change status rule.
2. Create via = File » New - Snapshot

=

i Schnappschuss erstellen 2

Mame

Beschreibung

8] Abbrechen

A new folder (type Snapshot) with the referenced snapshot data is stored in the folder
“Newstuff”.

It is recommended to attach the snapshot to an element change status.

a.) Copy the snapshot folder to the clipboard

b.) Select the element modification state and choose - Edit - Insert content
c.) Select the type 2D snapshot and confirm the dialog

You open a snapshot by simply sending it to the Structure Manager.

5.3.11.3. Baseline

Baselines correspond approximately to a development status documentation, which contains a copy
of the entire “in progress” data for the structure.

With a baseline, Teamcenter creates a new dataset and attaches a copy of the configured structure to
it. Teamcenter creates a new change status in the structure for each unreleased change status and
releases it with a predefined status, for example with the status Baseline. A baseline change state
rule is then applied to the base configuration (for example to change states with the status
Production) and all new change states created by “Baseline” are also added. This procedure
configures a fully released structure and thus ensures that the models are always the same at the
time of baseline creation.

Create baselines sparingly, as each baseline creates a fully released structure and thus (possibly)
many new element change states and copies of the linked data and CAD models are created!

5.4. comparison of product structures

5.4.1. basics

With the command “Compare” you can display and compare the structural differences. The
comparison is performed on the extended structure and you can select the areas of the structure to
be compared. You can define the change status rule and the variant rule separately for each
structure, allowing different configurations to be compared.

The comparison determines the differences in number and change status in three modes:

|1.|Sing|e-|eve|
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Compares only the first level of product structures.
2.Multilevel

Performs a one-step comparison at the top level and then performs further one-step comparisons
on the subassemblies that occur in the two product structures.

3./Low level only

Compares only the parts at the lowest level in the product structure, ignoring any assemblies that
exist above it in the meantime. This is useful for checking whether individual parts are consistent.

5.4.2. procedure
You can use these comparisons

e Detect component differences between assemblies
» Perform consistency check between multiple views of the same part
e Determine differences between different configured structures

preparation:

1. Load the first module as usual
2. Splitting windows
i |
3. Possibly click on the empty window to set it to active
4, Load a second assembly from My Teamcenter

Send to - Structure Manager

5. Menu item - Tools -» Compare

An example of a single-level comparison with a BOM comparison report:
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X.0001.8631-00 MULTI SPINDLE HEAD | MEHRSPINDELKOPF (Ansicht) - Latest Working - Datum - "Heute" B0 (1| | %.0004.7679-00 MULTI SPINDLE HEAD | MEHRSPINDELKOPF (Ansicht) - Latest Working - Datum - "Heute" £ |
Stucklisteneintrag | cEOMETRE Regel konfiquriertvon | Eleme..] Pos. | Menge | Stucklisteneintrag GEOMETRIE Regel konfiguriertvon | Eleme..] Pos. | Menge

|5 X0001.8631-00 MULTI HEAD | MEHRSPINDELKO... EAD | MEHRSPINDELKO...

In Arbeit( ) 10 j In Arbeit( ) 10

In Arbeit( ) 2 e In Arbeit( ) 20

In Arbeit( ) EY j In Arbeit( ) 20

In Arbeit( ) “ j In Arbeit( ) 40

® Sticklistenvergleich ==
Modus: Einzelebene (mit Pos) -
Bericht
Anwenden Abbrechen
» “
Sticki hsbericht - X.0001 8631-00 MULTI SPINDLE HEAD | MEHRSPINDELKOPF (Ansicht) -» X.0004.7673-00 MULTI SPINDLE HEAD | MEHRSPINDELKOPF (Ansicht) {mit Poz) _LH Var: Kein LH Rev:Latest Working _RH Var: Kein RH ReviLatest Working

Element 1D Elementname Pos. Anderungsstand Anz Mehrfeldschiassel-Informationen fur Element
X.0001.8637 IABSTECKBOLZEN 10 00->() 1->0 s=item i1d=X.0001.8637,cbject_type...
X.0004.7680 IABSTECKBOLZEN 10 (0->00 0->1 =: 68! bject_type...
X.0001.8637 IABSTECKBOLZEN 20 00->() 1->0 ._type.
X.0004.7620 |RBSTECKBOLZEN 20 ()->00 0->1 ._type
%.0001.2642 [x.0001.8642 30 00->() 1-50 N e L2642, 0b32ct_type...
3.0004. 7684 e.0001. 8642 30 () ->00 01 W ,=item_id=¥.0004.7688,cbject_type..

At the end the comparison can be removed again in the menu - Tools - Delete comparison.

5.5 Working with "auxiliary parts" and non-geometric parts

5.5.1 Overview

This specification provides for a single integrated structure, i.e. both the “design view” and the
“production view” must be able to be mapped consistently in this structure.

An essential aspect of this concept is the fact that in the previous PLM system Agile there is a
separate design structure “document structure” and a product structure “article structure” and
these must be merged into an integrated overall structure.

The differences in the use of the components are called “non-geometric parts” and “auxiliary
parts”.

5.5.2 Non-geometric parts

Non-geometric parts are those that are not included in the design structure, but are nevertheless
procured via the product structure. Examples are glue, oil, or text items.

The CAD system NX is inherently capable of hiding parts without geometry or marking them as “non-
geometric”. For this purpose, the Occurence-Note “UG GEOMETRY” is set to the value “NO” at a
revision in the BOMLine.

Example: The following assembly contains non-geometric parts (GEOMETRY=NO).
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[3] Struktur-Management 53

#.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUMNG (Ansicht] - Latest Working - Datum - "Heute"

Stacklisteneintrag I GEOMETRIE SAP Transfer Pos.
= X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT...
-9 X.0000.2057-00 SWIVELLING CLAMP CYL. | SCHWEN... N 10
@ X.0000.2058-00 CLAMPING IRON | SPANNEISEN N 10
g X.0000.2058-00 HOUSING | GEHAEUSE N 20
-4 P (.9000.0000-00 NO 5
~-g3P X.0000.2060-00 BASE PLATE | GRUMDPLATTE 20
-3 ¥=) ¥.0000.2061-00 BRIDGE | BRUECKE 30
- ¥=) ¥.0000.2062-00 INDEX | INDEX 40
g ¥.0000.2063-00 BRIDGE | BRUECKE 50
g X.0000.2064-00 WORKPIECE | WERKSTUECK 60
g X.0000.2065-00 INDEX | INDEX 70
g X.0000.2066-00 PAD | AUFLAGE 80
g3 P ¥.0000.2067-00 SUE. DET. F. WELDMENT | HILFSTEIL NO 90
g P X.0000.2058-00 CLAMPING IRON | SPANNEISEN — NO 100
- F X.0000.2053-00 HOUSING | GEHAEUSE NO 110
The representation in NX looks as follows:
0 Baugruppen- Navigater
Objekt & Nummer Anderu...
+- [z Schnitte
- [A(#, X.0000.2056-00 CLAMPING FIXTURE | SPAN... | X.0000.2056 00
A (¢ X.0000.2060-00 BASE PLATE | GRUNDPLATTE | X.0000.2060 00
+EL[3 X.0000.2057-00 SWIVELLING CLAMP CYL. | ... | X.0000.2057 a0
- g ¥.0000.2064-00 WORKPIECE | WERKSTUECK | X.0000.2064 00
- £ X.0000.2062-00 INDEX | INDEX X.0000.2062 00
1 (g X.0000.2086-00 PAD | AUFLAGE X.0000.2066 L]}
A (@ X.0000.2065-00 INDEX | INDEX X.0000.2065 a0
- g X.0000.2063-00 BRIDGE | BRUECKE X.0000.2063 a0
- (4 X.0000.2061-00 BRIDGE | BRUECKE X.0000.2061 00
.0000.2067-00 SUB. DET. F. WELDMENT | ... | X.0000.2067 0o
%.0000.2058-00 CLAMPING IRON | SPANNE... | X.0000.2058 00
%.0000.2059-00 HOUSING | GEHAEUSE X.0000.2059 00

5.5.2.1 Setting non-geometric components in NX

In NX a component can be marked as non-geometric via RMB - Properties - “Component is Non-
Geometric”.
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¥~ X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUNG @ @

[ Baugruppen-Navigator

Teiledatei

¥ Komponente Eigenschaften

Allgemein

Objekt =~

+ Ol Schnitte

S [¥#1(# X.0000.2056-00 CLAMPING FIXTURE | SPAN...

-} (@ X.0000.2060-00 BASE PLATE | GRUNDPLATTE

+- [y X.0000.2057-00 SWIVELLING CLAMP CYL. | ...

~[ (@ X.0000.2064-00 WORKPIECE | WERKSTUECK

-} (@ X.0000.2062-00 INDEX | INDEX

- @ ¥.0000.2066-00 PAD | AUFLAGE

- (@ ¥.0000.2065-00 INDEX | INDEX

b (@ X.0000.2063-00 BRIDGE | BRUECKE

| (@ X.0000.2061-00 BRIDGE | BRUECKE

0 SUB. DET. F. WELDMENT | ...

X.0000.2058-00 CLAMPING IRON | SPANME...

%.0000.2059-00 HOUSING | GEHAEUSE

Baugruppe Attribute

Allgemein v
Komponente A
[] Komponente dient ausschlieBlich als Refersnz

I Komponente ist nicht geometrisch ||
Stuckzahl v
Informationen v

«
Trimetrisch AREEIT Kamera Trimelrisch

MNummer

X.0000.2056
X.0000.2060
X.0000.2057
X.0000.2064
X.0000.2062
X.0000.2066
X.0000.2065
X.0000.2063
X.0000.2061

X.0000.2058
X.0000.2059

Anderu...

Info

5.5.2.2 Setting non-geometric components in Teamcenter

In Teamcenter a component can be set to non-geometric in the Structure Manager by setting the

Occurrence Note “GEOMETRY” to “NO”.

[#] Struktur-Management 53

£.0000.2056-00 CLAMPING FIXTURE | SPANMNVORRICHTUMNG (Ansicht) - Latest Working - Datum - "Heute"

Stiicklisteneintrag GEOMETRIE SAP Transfer Pos, I Eig...I Referenzkennung Elernent
¥ X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT...
-9 X.0000.2057-00 SWIVELLING CLAMP CYL. | SCHWEN... N 10
& X.0000.2058-00 CLAMPING IRON | SPANMEISEN N 10

P X.0000.2059-00 HOUSING | GEHAEUSE M 20
&P [P G.9000.0000-00 NO 5 SE
¢ X.0000.2060-00 BASE PLATE | GRUNDPLATTE 20
- ) X.0000.2061-00 BRIDGE | BRUECKE 30
- 5 X.0000.2062-00 INDEX | INDEX 40
¢ X.0000.2063-00 BRIDGE | BRUECKE 50
¢ X.0000.2064-00 WORKPIECE | WERKSTUECK &0
¢ X.0000.2065-00 INDEX | INDEX 70
-2 X.0000.2066-00 PAD | AUFLAGE 80
--#3 [ X.0000.2067-00 SUB. DET. F. WELDMENT | HILFSTEI a0
-0 [ %.0000.2058-00 CLAMPING IROM | SPAMNEISEN MO 100

9L X0000.2053-00 HOUSING | GEHAEUSE Mo ri; Notiz fiir X.0000.2067-00 SUB. DET. F. WELDMENT | HILFSTEIL S

GEOMETRIE

Mo

oK | [ Abbrechen
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5.5.3 "Auxiliary parts"

An “auxiliary part “ is a part in a bill of material that is not to be transferred to the ERP system
(SAP). Usually, such parts are used to group parts together or they are built into the structure for
functional reasons. In general, these parts have geometry, i.e. they are displayed in the CAD system
and used in the CAD structure. By default, Teamcenter/NX does not offer the possibility to mark such
parts as “non ERP-relevant”. Therefore, the Occurrence-Note “FFG4occSAPTransfer” is introduced,
which makes it clear to the SAP interface whether this node (component or whole sub-assembly)
should be flitted out during the SAP transfer.

5.5.3.1 Logic for the SAP transfer

If the value “N” is set, the corresponding node is not transferred, that is, the entire branch is filtered
out, regardless of whether the nodes below it have set the SAP transfer flag or not. If the flag has no
value, the node is transferred to SAP.

Struktur-Management @3

X.0000.2056-00 CLAMPING FIXTURE | SPANMNVORRICHTUMG (Ansicht) - Latest Working - Datum - "Heute"

Stiicklisteneintrag GEOMETRIE SAP Transfer ™ Pos. | Eig...
& X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT. .

=g X.0000.2057-00 SWIVELLING CLAMP CYL. | SCHWEN... N 10
& X.0000.2058-00 CLAMPING IRON | SPANMEISEN N 10
@ X.0000.2059-00 HOUSING | GEHAEUSE N 20
~¢ 3 G.9000.0000-00 MO 5
g3 ¥.0000.2080-00 BASE PLATE | GRUNPRLATIE an .
%% X.0000.2061-00 BRIDGE | BRUEC & Motiz fir X.0000.2058-00 CLAMPING IRON | SRANNEISEN &J

- 0 X.0000.2062-00 INDEX | INDEX

- SAP Transfer
& X.0000.2063-00 BRIDGE | BRUECKE j _
& X.0000.2064-00 WORKPIECE | WERK] | Angehangte Werteliste [N >
& X.0000.2065-00 INDEX | INDEX N Wert Beschreibung
- X0000.2066-00 PAD |AUFLAGE ||| .. N | No SAP Transfer

¢ (B ¥.0000.2067-00 SUB. DET. F, WEL
- (B ¥.0000.2058-00 CLAMPING IRON
--#3P (O ¥.0000.2059-00 HOUSING | GEHA

oK | | Abbrechen |

5.5.3.2 Marking "Auxiliary parts" in Teamcenter

In Structure Manager you can edit the value of the Occurrence Note by double-clicking on the
corresponding column. Possible values are “N” or an empty field.

5.5.4 Display in the Structure Manager

In the Structure Manager, a structure can be filtered according to criteria. ClosureRules are used for
filtering. In the preference ClosureRulesForBomExpansion those ClosureRules are defined, which
can be used in the Structure Manager to display the structure. The structure itself is not changed.

5.5.4.1 Setting the view via the Closure Rule

A view in the Structure Manager can be set as follows: Tools » “Set/display closing rule for
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enhancements “

Datei Bearbeiten Ansicht | Werkzeuge | Fenster Hilfe

) | of B | ®x | Einchecken/Auschecken r E D | - = ST " I T T | | ¥ {E)} -
@~ @~ struktur|  Projskt b IFG/ Plot - [ dev00 1[000021[1[ 1 [ 1
And stand | 3
NEEIE S R ktur-Management &3
~ Suchen Gulltigkeit ,
00002056 2056-00 CLAMPING FIXTURE | SPANNVORRICHTUNG (Ansicht) - Latest Working - Datum - "Heute”
= ~ . ;
- Quick.Links | sm  Abschlussregel fir Erweiterung anzeigen,/festlegen e | GEOMETRIE SAP Transfer &
o Alle Verlaufs-Zeilen v 0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT...
& Persanliche Ablage ¥ 3.0000.2057-00 SWIVELLING CLAMP CYL. | SCHWEN...
&5 Meine Arbeitsliste Exportieren g X.0000.2058-00 CLAMPING IRON | SPANMNEISEN
4 Meine gespeicherten Suc i g X.0000.2059-00 HOUSING | GEHAEUSE
. . @ Baseline...
¥ Meine Links V(7 G.9000.0000-00 NO
@' Globale Alternativen verwalten ' X.0000.2060-00 BASE PLATE | GRUNDPLATTE
 Offene Elemente Vergleichen... FYB X.0000.2061-00 BRIDGE | BRUECKE
_ o P% X.0000.2062-00 INDEX | INDEX
& X.0000.2056-00 CLAMPIN erlechiicechen V' X.0000.2063-00 BRIDGE | BRUECKE
P X.0000.2056 CLAMPING Fl 2§ Grafischer Sticklistenvergleich ¥ X.0000.2064-00 WORKPIECE | WERKSTUECK
&b Home “% Zwischenzeitliche Datenerfassung... ¥ X.0000.2065-00 INDEX | INDEX
. ? X.0000.2066-00 PAD | AUFLAGE
Al il * PP X.0000.2067-00 SUB. DET. F. WELDMENT | HILFSTEIL NO
; &5 X.0000.2058-00 CLAMPING IROM | SPANMEISEN NO
&5 %.0000.2053-00 HOUSING | GEHAEUSE NO
The dialog for the closing rules opens:
¥ ~
@ Abschlussregel fiir Erweiterung anzeigen/festlegen - FFG4BOMExpandSkipBySAPTransfer =

=

Abschlussregeln

BOMExpandSkipByProjAssignmen
BOMExpandProcessByProjectAssic Bedingungsklauseln
BOMExpandSkipByltemType
BOMExpandProcessByltemType
BOMExpandSkipByVariableltem Ty
BOMExpProcessVariableltemType BOMLine Item bl_item SKIP PRIMARY FFG4cccSAPTransfer=="N"
BOMExpandSkipByPartSource
BOMExpandProcessByPartSource
BOMExpandAlternativeScope
FFG4BOMExpandProcessByPartTy)
FFGABOMExpandSkipByGeomet

Beschreibung  Skip expansion of BOMLine based on bomline property. The qualified BOMLine will be visible,

Primndres ...  Sekunddr.. Verbunde.. Aktionstyp Bedingungsklausel

’ OK l [ Abbrechen Festlegung der Regel aufheben

Select the desired rule and confirm it with OK.

The view is updated according to the rule.
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Struktur-Management 3

X.0000.2056-00 CLAMPIMG FIXTURE | SPAMNVORRICHTUNG (Ansicht) - Latest Working - Datum - "Heute" - FFG4BOMExpandSkipBySAPTransfer

| Sticklisteneintrag GEOMETRIE SAP Transfer Pos. | Eig...l Referenzkennung

E X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT...
- 5.9000.0000-00 NO

- ¥.0000.2060-00 BASE PLATE | GRUMDPLATTE

- %5 X.0000.2061-00 BRIDGE | ERUECKE

ﬁ@ X.0000.2062-00 INDEX | INDEX

¢ ¥.0000.2063-00 BRIDGE | BRUECKE

-3 ¥.0000.2064-00 WORKPIECE | WERKSTUECK

-3 X.0000.2065-00 INDEX | INDEX

- ¥.0000.2066-00 PAD | AUFLAGE

- 3 X.0000.2067-00 SUB. DET. F. WELDMENT | HILFSTEIL NO

- [ X.0000.2058-00 CLAMPING IROM | SPAMMEISEN NO

-3 B X.0000.2059-00 HOUSING | GEHAEUSE NO

To reset the view, press “Cancel rule definition” in the previous dialog.

¥ ~

@ Abschlussregel fir Erweiterung anzeigen/festlegen - FFG4BOMExpandSkipBySAPTransfer =

=

Abschlussregeln

BOMExpandSkipByProjAssignmen
BOMExpandProcessByProjectAssic Bedingungsklauseln
BOMExpandSkipByltemType
BOMExpandProcessByltemType
BOMExpandSkipByVariableltem Ty
BOMExpProcessVariableltemType BOMLine Item bl_itern SKIP PRIMARY FFG4occSAPTransfer=="N"
BOMExpandSkipByPartSource
BOMExpandProcessByPartSource
BOMExpandAlternativeScope
FFG4BOMExpandProcessByPartTy)
FFGABOMExpandSkipByGeomet

Beschreibung  Skip expansion of BOMLine based on bomline property. The qualified BOMLine will be visible,

Primndres ...  Sekunddr.. Verbunde.. Aktionstyp Bedingungsklausel

oK | | Abbiechen

’ Festlegung der Regel aufheben

5.5.4.2 Examples

5.5.4.2.1 View of the unfiltered structure

Struktur-Management 3

X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUMNG (Ansicht) - Latest Working - Daturn - "Heute”

Stdcklisteneintrag I GEOMETRIE SAP Transfer Pos, I Eig...I Referenzkennung
a X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT...
E-g§ X.0000.2057-00 SWIVELLING CLAMP CYL. | SCHWEN...
@ X.0000.2058-00 CLAMPING IRON | SPAMNEISEN
‘gl X.0000.2059-00 HOUSING | GEHAEUSE

&P G.9000.0000-00 NO 5
& X.0000.2060-00 BASE PLATE | GRUNDPLATTE 10
--@P%®) X.0000.2061-00 BRIDGE | BRUECKE 0
&P %® X.0000.2062-00 INDEX | INDEX 10
& X.0000.2063-00 BRIDGE | BRUECKE 50

g ¥.0000.2064-00 WORKPIECE | WERKSTUECK 60

& X.0000.2065-00 INDEX | INDEX 70
@ X.0000.2066-00 PAD | AUFLAGE 80
- (3 X.0000.2067-00 SUB. DET. F. WELDMENT | HILFSTELL NO 90
P 3 X.0000.2058-00 CLAMPING IRON | SPANNEISEN ~ NO 100
- (3 X.0000.2059-00 HOUSING | GEHAEUSE NO 110
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5.5.4.2.2 Design view

E Struktur-Management =3

X.0000.2056-00 CLAMPING FIXTURE | SPANMVORRICHTUNG (Ansicht) - Latest Working - Datum - "Heute" - FFG4BOMExpandSkipByGeometry

Stiicklisteneintrag GEOMETRIE SA&P Transfer Pos. | Eig...l Referenzkennung Elementﬂnderungss...l Regel konfigur
y' ¥.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT...
g9 X.0000.2057-00 SWIVELLING CLAMP CVL. | SCHWEN... N 10 In Arbeit( )

& X.0000.2058-00 CLAMPING IROM | SPANMEISEN N 10 In Arbeit( )

& X.0000.2059-00 HOUSING | GEHAEUSE M 20 In Arbeit( )
9P X.0000.2060-00 BASE PLATE | GRUNDPLATTE 20 In Arbeit( )
%) X.0000.2061-00 ERIDGE | BRUECKE 30 In Arbeit( )

&% X.0000.2062-00 INDEX | INDEX 40 In Arbeit( )
~-£3 ¥.0000.2063-00 BRIDGE | BRUECKE 50 In Arbeit( )
g3 X.0000.2064-00 WORKPIECE | WERKSTUECK 60 In Arbeit( )
g ¥.0000.2065-00 INDEX | INDEX 70 In Arbeit( )
g9 X.0000.2066-00 PAD | AUFLAGE 80 In Arbeit( )

- ~
& Abschlussregel fur Erweiterung anzeigen/festlegen - FFG4BOMExpandSkipByGeometry ﬂ
L)
Abschlussregeln Beschreibung  Skip expansion of BOMLine based on bomline property. The qualified BOMLine will be visible,
BOMExpandSkipByProjAssignment
BOMExpandProcessByProjectAssign Bedingungsklauseln
BOMExpandSkipByltemType
BOMExpandProcessByltemType Priméres.. Sekundar.. Verbunde.. Aktionstyp  Bedingungsklausel
BOMExpandSkipByVariableltern Type
BOMExpProcessVariablelternType BOMLine Ttem bl_item SKIP PRIMARY.UG GEOMETRY=="N0Q"
BOMExpandSkipByPartSource
BOMExpandProcessByPartSource
BOMExpandAlternativeScope
ocessByPart
metry
OK ] [ Abbrechen ] [Futlegung der Regel aufheben
5.5.4.2.3 SAP view
[ Struktur-Management 53
X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUMG (Ansicht) - Latest Werking - Datum - "Heute" - FFG4BOMExpandSkipBySAPTransfer D [
Sticklisteneintrag GEOMETRIE SAP Transfer T | Pos. [Eig.. Referenzkennung Elementénderungss...| Regel konfiguriert von MaBeinheit [
ﬂ? X.0000.2056-00 CLAMPING FIXTURE | SPAMNVORRICHT...
95 (6.9000.0000-00 NO 5 SE Hat Status( Beliebiger Fr... jede GEOME
9 X.0000.2060-00 BASE PLATE | GRUNDPLATTE 20 In Arbeit( ) Jjede Referen
a@ ¥.0000.2061-00 BRIDGE | BRUECKE 30 In Arbeit( ) Jjede Referen
&% X.0000.2062-00 INDEX | INDEX 40 In Arbeit( ) jede Referen
a X.0000.2063-00 BRIDGE | BRUECKE 50 In Arbeit( ) Jede ENTITY-
a X.0000.2064-00 WORKPIECE | WERKSTUECK 60 In Arbeit( ) Jede ENTITY-
a X.0000.2065-00 INDEX | INDEX 70 In Arbeit( ) Jjede Referen
a ¥.0000.2066-00 PAD | AUFLAGE 80 In Arbeit( ) jede Referen
(3 %.0000.2067-00 SUB. DET. F. WELDMENT | HILFSTEL NO "5 pioc chiussregel fir Erweiterung anzeigen/festiegen - FFGABOMExpandSkipBySAPTransfer =)
aﬂ X.0000.2058-00 CLAMPING IRON | SPANNEISEN NO =
aﬂ X.0000.2059-00 HOUSING | GEHAEUSE NO (]
Abschlussregeln Beschreibung  Skip expansion of BOMLine based on bomline property. The qualified BOMLine will be visible,
BOMExpandSkipByProjAssignment
BOMExpandProcessByProjectAssign Bedingungsklauseln
BOMExpandSkipByltemType
BOMExpandProcessByitemType Priméres .. Sekundir. Verbunde.. Aktionstyp Bedingungsklausel
BOMExpandSkipByVariableltemType
BOMExpProcessVariableltemType BOMLine  hem bl_item SKIP PRIMARY.FFGAoccSAPTransfer==
BOMExpandSkipByPartSource
BOMExpandProcessByPartSource
BOMExpandAltemativeScope
FFG4BOMExpandProcessByPartType
4RONMFxpand Eometry
FFGABOMExpand! AP Transfer
oK ] Abbrechen | [Festlegung der Regel aufheben

5.5.4.3 Comparison of the views

In the Structure Manager, design and SAP views can be displayed side by side and compared. To do
this, first open a new window with the selected button.
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[#] Struktur-Management 5 =0
X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUNG (Ansicht) - Latest Working - Datum - "Heute”
Stacklisteneintrag GEOMETRIE SAP Transfer © Pos. [Eig.. Referenzkennung Elementanderungss...| Regel kenfiguriert von MaBeinheit
1% X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT...
& X0000.2057-00 SWIVELLING CLAMP CYL, | SCHWEN... N 10 In Arbeit( ) jede
B ﬁ X.0000.2058-00 CLAMPING IRON | SPANMEISEN N 10 In Arbeit( } jede Reference Set, ENTIT
ﬁ X.0000.2059-00 HOUSING | GEHAEUSE N 20 In Arbeit( ) Jjede Reference Set, ENTIT
é‘ﬂ G.2000.0000-00 NO 5 SE Hat Status{ Beliebiger Fr... jede GEOMETRIE,NX-NAI
é‘ X.0000.2060-00 BASE PLATE | GRUNDPLATTE 20 In Arbeit( ) Jjede Reference Set, ENTIT
é‘@ %.0000.2061-00 BRIDGE | BRUECKE 30 In Arbeit( ) jede Reference Set, ENTIT
- @9 X.0000.2062-00 INDEX | INDEX 0 In Arbeit( ) jede Reference Set, ENTIT
& X.0000.2063-00 BRIDGE | BRUECKE 50 In Arbeit( ) jede ENTITY-HANDLE: RI
& X.0000.2064-00 WORKPIECE | WERKSTUECK 60 In Arbeit( ) jede ENTITY-HANDLE N
- a .0000.2065-00 INDEX | INDEX 70 In Arbeit( } jede Reference Set, ENTIT
é‘ X.0000.2066-00 PAD | AUFLAGE 80 In Arbeit( ) Jjede Reference Set, ENTIT
é‘ﬂ X.0000.2067-00 SUB. DET. F. WELDMENT | HILFSTEIL NO 90 In Arbeit( ) Jjede GEOMETRIE,NX-NAI
é‘ﬂ %.0000.2058-00 CLAMPING IRON | SPANNEISEN NO 100 In Arbeit( ) Jjede Reference Set,NX-MN.
é‘ﬂ .0000.2059-00 HOUSING | GEHAEUSE NO 110 In Arbeit( ) jede Reference Set,NX-MN.

Afterwards the Structure can be opened in the Teamcenter Navigator via RMT -> “Send to” ->

“Structure Manager “ in this new window.
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The comparison can be started via “Tools” -> “Comparison... “.

Example: Comparison of the entire structure with the design structure:
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[# Struktur-Management 52

¥.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUNG [Ansicht) - Latest Working - D... [ []]| .0000.206-00 CLAMPING FIXTURE | SPANNVORRICHTUNG [Ansicht) - Latest Working - D... [] CNE)
Stacklisteneintrag [ crometre [ sapTranster v | Stucklisteneintrag [ crometre [ sapTranster |

' %.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT... 9 X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHT...

- X,0000.2057-00 SWIVELLING CLAMP CYL, | SCHWEN... N 10 & X.0000.2057-00 SWIVELLING CLAMP CYL. | SCHWEN.., N 10
i@ X.0000.2058-00 CLAMPING IRON | SPANNEISEN N 10 & X.0000.2058-00 CLAMPING IRON | SPANNEISEN N 10
@ X.0000.2059-00 HOUSING | GEHAEUSE N 20 @ X.0000.2059-00 HOUSING | GEHAEUSE N 20

0 R 5 & X0000.2060-00 BASE PLATE | GRUNDPLATTE bl
& X.0000.2060-00 BASE PLATE | GRUNDPLATTE 20 %9 %.0000.2061-00 BRIDGE | BRUECKE 30
--#P% X.0000.2061-00 BRIDGE | BRUECKE 30 % X.0000.2062-00 INDEX | INDEX 40
@0 %) X.0000.2062-00 INDEX | INDEX 40 & X.0000.2063-00 BRIDGE | BRUECKE 50
& X.0000.2063-00 BRIDGE | BRUECKE 50 & X.0000.2064-00 WORKPIECE | WERKSTUECK 60
& X.0000.2064-00 WORKPIECE | WERKSTUECK 60 & X.0000.2065-00 INDEX | INDEX 70
@ X.0000.2065-00 INDEX | INDEX 0 & X.0000.2066-00 PAD | AUFLAGE 80
@ X.0000.2066-00 PAD | AUFLAGE 80
0 NO %0
70 NO 100
- an) NO 110
¥ Stucklistenvergleich | = ‘
Meodus: :Mum-Ebene (mit Pos.) v:
Bericht
[ Anwenden ] [ Abbrechen
“ 1 r “ 1 r

Stacklistenvergleichsbericht - X.0000.2056-00 CLAMPING FIXTURE | SPANNYORRICHTUNG (Ansicht) -> X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUNG (Ansicht) Multi-Ebene (mit Pos.) LH Var: Kein LH Rev:Latest...

Elerent-10 Elementname Pos. Anderungsstand Anz Me
X.0000.2056 -
5.9000.0000 5.3000.0000 5 00->{) 1->0
X.0000.2067 SUB. DET. F. WELDMENT 90 00->{) 1->0
X.0000.2058 CLAMPING IRON 100 00->{) 1->0

< I ]

(&

Example: Comparison of the entire structure with the SAP structure:

[ struktur-Management 53 = 0O

X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUNG (Ansicht) - Latest Working - ... [ [} .0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUNG (Ansicht) - Latest Working - . ] [ [ [
Sticklisteneintrag [ crometRIE | sAP Transfer v | Stiicklisteneintrag | GrOMETRIE | SAPTransfer |
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-+ [K0000.2057-00 SWIVELLING CLAMP CYL. | SCHWEN...| N 1] || -3 6.9000.0000-00 NO 5
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&3 ¥.0000.2059-00 HOUSING | GEHAEUSE N 2 || - #P%® %.0000.2061-00 BRIDGE | BRUECKE 3

@3 6.9000.0000-00 NO 5 ||| i #9% x.0000.2062-00 INDEX | INDEX 4
& X.0000.2060-00 BASE PLATE | GRUNDPLATTE 2q|| - x.0000.2063-00 BRIDGE | BRUECKE 5
&P ¥.0000.2061-00 BRIDGE | BRUECKE 3|| - x.0000.2064-00 WORKPIECE | WERKSTUECK 6
&%) ¥.0000.2062-00 INDEX | INDEX ag]|| - x.0000.2065-00 INDEX | INDEX 7
& X.0000.2063-00 BRIDGE | BRUECKE sql|| - x.0000.2066-00 PAD | AUFLAGE 8
& X.0000.2064-00 WORKPIECE | WERKSTUECK 6q|| i P %.0000.2067-00 SUB. DET. F. WELDMENT | HILFSTELL NO i
& X.0000.2065-00 INDEX | INDEX 7¢|| i #PFF %.0000.2058-00 CLAMPING IRON | SPANNEISEN  NO 1
& X.0000.2066-00 PAD | AUFLAGE a|| 9P %.0000.2059-00 HOUSING | GEHAEUSE NO 1
- &P(3 ¥.0000.2067-00 SUB. DET. F. WELDMENT | HILFSTEIL NO o

&P (7 ¥.0000.2058-00 CLAMPING IRON | SPANNEISEN  NO 1

&P (3 ¥.0000.2059-00 HOUSING | GEHAEUSE NO 11

4 n (2 4 i 3

Sticklistenvergleichsbericht - X.0000.2056-00 CLAMPING FIXTURE | SPANNYORRICHTUNG (Ansicht) -»> X.0000.2056-00 CLAMPING FIXTURE | SPANMYORRICHTUMG (Ansicht) Multi-Ebene (mit Pos)  LH Var Kein LH ReviL...

Elernent-1D Elementname Pos. Anderungsstand Anz | Mehrfeldschlissel-Informationen...

¥.0000.2056 | | | | |
|

¥.0000.2057 |swivELLING cLamp cyL. 10 Joo—>n) [1->0 ,=item_id=X.0000.2057,0b. ..

o | I ] »

Example: Comparison of the design structure with the SAP structure:
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Stiicklistenvergleichsbericht - X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUNG (Ansicht] -> X.0000.2056-00 CLAMPING FIXTURE | SPANNVORRICHTUMNG (Ansicht) Multi-Ebene (mit Pos) LH Var: Kein LH Rev:L...
Element-1D Elementname Pos. Anderungsstand Anz Mehrfeldschlissel-Informatione...
¥.0000.2056
G.5000.0000 G.59000.0000 5 {)->00 0->1 ,=item_ id=G.9000.0000,ck...
X.0000.2057 SWIVELLING CLAIMP CYL. 10 00->{) 1-»0 ,=item id=¥.0000.2057,cb...
X.0000.2087 SUB. DET. F. WELDMENT a0 {)->00 0->1 ,=item id=¥.0000.2067,cb...
X.0000.2058 CLEMPING IRON 100 {)->00 0->1 ,=item id=¥.0000.2058,cb...
X.0000.2059 HOUSING 110 {)->00 0->1 ,=item id=¥.0000.2059,cb...
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